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7.1 Objectives 

 Create a superelevation section and lane 

 Calculate superelevation using a SEP file, or import data from CSV file 

 Review / edit the data utilizing the table editor 

 Assign the superelevation information to a corridor 

7.2 Overview 

Superelevation tools calculate how much banking to apply to curves and spirals in the 

horizontal alignment to help offset centrifugal force. These commands also compute how 

the road will make the transition from normal crown to a fully banked curve and back again. 

Superelevation can be calculated in two ways: 

Rules-based – using a set of preferences (SEP file) the station and associated cross slopes 

of the transitions are based on design speed, curvature, and other design parameters. As the 

design progresses and parameters change (i.e., design speed exceptions) superelevation can 

be reprocessed to the revised parameter(s). 

Import – using a comma separate values (CSV) file to import the station and associated 

cross slope of each transition. In this option, the rules are not utilized; the data is simply 

applied to the superelevation lanes. 

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope 

attributes. This file can be referenced to a corridor model and associated, so the 

superelevation transitions are incorporated into the corridor model. The superelevation data 

can be in its own DGN file, or can be drawn into any of the other project DGN files with 

geometry, corridor, etc. 

7.3 Prerequisites 

In order to create superelevation, the following are minimum requirements: 

 One Civil horizontal geometry element 

 Superelevation preferences (an SEP file set) - each of these preference files calls out 

other files within it so be sure you have the entire set 

In order to add the superelevation data to a corridor, you will need: 

 Superelevation lanes 

 Corridor whose template has superelevation flags for control points (for association 

step) 

Superelevation data is drawn using the active MicroStation attributes, so no features or 

element templates are used or supported.  Therefore, turning off the level with superelevation 

data removes it from the active view. 
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7.4 Settings 

The following two sets of settings are utilized within the superelevation tools. It is prudent to 

set them prior to drawing lanes. There are no required values; these are user preference. 

 fill settings for superelevation lanes 

 decimal place settings for element handlers 

7.5 Fill Settings 

Located under Workspace> Preferences from the main MicroStation or Power product 

menu, the View Options - Civil listing provides options for the superelevation fill. 

 
Option Description 

Color Shaded 
Fill 

Color Shaded Fill Color fills superelevation lanes AFTER calculations are complete. The coloring 
is hard-coded based on the cross slope: 

 

slope < -10% =blue 
 

-10% <= slope <= -0.5% = Calculated color between green and blue 

 

-0.5% < slope < 0.5% = white 
 

0.5% <= slope <= 10% = Calculated color between red and yellow slope > 10% = dark red 

Based on the side of road, the colors flip. In addition to setting this option, the View Attribute for 
Fill must also be toggled on. 

Boundaries 

Only 

In this option, only the outside boundary of each lane is displayed and can be selected. 

None No superelevation lanes / edit handlers are displayed; however, they are still in the file. To display 
them, set to one of the other two options. 
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7.6 Stationing and Decimal Place Settings 

Located under Settings > Design File from the main MicroStation or Power GEOPAK 

product menu, the Civil Formatting category listing has options for controlling display of 

element handlers. These settings are not unique to superelevation; the same settings are used 

throughout the Civil products. 

 
Option Description 

Station Settings: Used for section and lane edit handlers. 

Format Controls the number of places after the delimiter. 

Format Delimiter Controls the delimiter, generally the plus (+) sign. 

Precision Defines the number of decimal places for stationing. 

Profile Settings: Used for lane edit handlers. 

Slope Format Used for cross slope edit handlers. Generally set to percentage for superelevation. 

Slope Precision Defines number of decimal places in cross slope edit handlers. 

Superelevation General Workflow 

The general workflow for superelevation is described in the following steps. Steps 4-6 

can be done in a different order and not all steps are required. 

1. Create the super section(s). 

2. Define the lanes with Create Superelevation Lanes. 

3. Calculate superelevation transitions and cross slopes. 

4. Review and edit as needed. 

5. Add auxiliary lanes. 

6. Associate to a corridor. 

7.7  Create the Super Section(s) 

In this first step, the Civil horizontal geometry element is identified, and station limits of the 

superelevation are defined. Station limits are useful if the horizontal geometry element is 

substantially longer than the project limits. 

In a basic project where the through lane pavement configuration is consistent (i.e., all 2 lane 

rural with a few turn lanes), a single section may be used. However, if there are significant 

changes to the road, i.e., changing from 2 lane rural to 4 lane divided, separate sections 

should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot method changes. The changes should be based on the 

through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits and truck 

climbing lanes are handled independently. If you are importing superelevation, one section 

can be used for an entire alignment. 
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7.7.1 Create Superelevation Lanes 

Once the section is defined, define the lanes. Focus on the through lanes, as the turn lanes and 

intermittent lanes can be added at any time. Lanes are defined by selection of the horizontal 

geometry and offsets. Default cross slope, used for subsequent calculations, is also defined. 

The result of this step is that graphic lanes (filled with green and yellow, no choice of colors) 

are drawn. 

7.7.2 Calculate Superelevation Transitions and Cross Slopes 

In this step, there are two options: rule-based and imported data. Generally, one method 

would be selected, however, you can use rule-based for part of the project and import other 

parts (although this would be confusing). 

The rules-based tool uses a preferences file (SEP file) to compute the station and cross slopes 

of transitions, while the import superelevation method uses a comma separate values (CSV) 

file containing the station and cross slopes, which were calculated by an exterior program (or 

manually). The inputs vary depending on the method used and the preferences within the 

SEP file. 

The result of this step is the augmentation of station/cross slopes of transitions to the lanes 

created in the previous step. It is easy to see the results if the fill is toggled on as the lanes 

change from solid yellow and green to a gradient coloring, based on cross slopes. 

7.7.3 Review and Edit as Needed 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed 

into the edit field. Slopes can be changed by keying the slope into the edit field. 

The superelevation editor is another way to edit the data, in a tabular format. Any changes 

made in the editor are automatically synced with the graphic lanes and vice versa. The fields 

in the editor can be customized so unused or unwanted fields can be hidden. Any data in gray 

cannot be edited, due to constraints used during calculations with the SEP method. 

7.7.4 Add Auxiliary Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) 

can be added. The result of this step is graphic superelevated primary or auxiliary lanes. 

7.7.5 Associate to a Corridor 

At any time during the process, the superelevated lanes can be associated with a corridor. If 

the superelevated lanes are in a different file than the corridor, you must be in the corridor 

file with the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 
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7.8 Accessing Superelevation Tools 

 

From the Corridor Modeling task group 

 Create Superelevation Sections - In this tool the Civil horizontal geometry element is 

identified and station limits of the superelevation are defined. Station limits are useful if the 

horizontal geometry element is substantially longer than the project limits. 

Determination of Sections 

If you are importing superelevation, one section can be used for an entire alignment. The 

advantage of curve sets for each curve versus one large section is the ability to reprocess 

rules for a single curve set or two. Since rules are not used in an imported project, separate 

curve sets serve no useful purpose aside from shorter, piecemeal reports and more 

granularities in the editor. 

In a basic rules-based project where the through lane pavement configuration is consistent 

(i.e., all 2 lane rural with a few turn lanes), a single section may be used. However, if 

there are significant changes to the road, i.e., changing from 2 lane rural to 4 lane divided, 

separate sections should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot/rotation method changes. The changes should be 

based on the through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits 

and truck climbing lanes are handled independently. However, the auxiliary lanes must be 

drawn within a single section. 

Workflow 

1. Select Create Superelevation Section. 

2. Follow the heads-up prompts. 

Prompt User Action 

Name Name each section, suggestions include alignment name which can be appended -1, 2, etc. for projects 

with multiple sections. 

 

Locate Reference 

Element 

Select the Civil horizontal element to be used as a basis for superelevation lanes and calculations. 

 

Start Station Graphically define (based on the dashed line perpendicular to the reference element) the beginning of 

the section. The station can also be keyed in and locked 

 

End Station Graphically define (based on the dashed line perpendicular to the reference element) the ending of the 

section. The station can also be keyed in and locked 

 

Minimum 

Tangent 

Length 

Enter a value (in master units). If the tangent distance between two adjacent curves is less the specified 

value, the two curves and adjacent tangent are drawn into one curve set. If the tangent distance between 

two adjacent curves is greater the specified value, each curve and half of the adjacent tangent are 

drawn into each curve set. At the completion of this prompt, the sections are drawn and the software 

automatically advances to the Create Superelevation Lanes tool 
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Minimum Tangent Length 

This variable defines the minimum tangent between curves and is the determining factor 

on how curve sets are defined. When using rule-based calculations, there are times when 

you need to reprocess part of the superelevation calculations, perhaps due to a horizontal 

geometry change or design speed revision. If your project is one big section, then 

reprocessing is performed on the entire section, and overwrites any manual editing. For 

flexibility, curve sets enable the processing of one curve or multiple curves, while leaving 

manually manipulated sets intact. In the following example, the distance between curves is 

234.57 master units. 

 

The following results illustrate the impact of the Minimum Tangent Length. 

 

 

This line separates the 
two superelevation 
sections. 
Example: first section 
may have a speed 
limit of 30 mph and 
the second section 
may have a speed 
limit of 25 mph. Using 
the Minimum Tangent 
Length will allow for 
separate 
superelevation 
sections to 
accomplish the task. 
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 Create Superelevation Lanes - At any time during the process, additional lanes can be 

added in any section. Primary lanes (those lanes that are rule based) or auxiliary lanes (those with 

user-specified cross slopes) can be added. The result of this step is graphic superelevated primary 

or auxiliary lanes. 

Workflow for Through Lanes 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts. 

 
Prompt User Action 

Locate First Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Locate Next Superelevation 
Section or Reset to 
Complete 

Continue selecting sections until all are highlighted, then reset to move to 
the next prompt. 

Enter Lane Name Name each lane, suggestions include RT or LT which can be appended -

1, 2, etc. for projects with multiple lanes. 

Select Side of Centerline Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Inside Edge Offset Enter the offset (in master units) from the baseline reference. If the lane 
edge is the baseline reference, enter 0. 

Width Enter the width of the lane (in master units). 

Normal Cross Slope Enter the default cross slope to be used for calculations (in percent format). It 

not necessary to add the percent sign. 

Name The prompts are looping again, so you can define multiple lines with a single 

selection of the tool. You may need to move the cursor slightly for the 

prompt to appear. When you have no additional lanes to define, reset to exit 

the tool. 
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Adding Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) can 

be added using the Create Superelevation tool, but within a single section. When a single 

section is selected, the prompts change to reflect adding an individual lane. The result of this 

step is graphic superelevated primary or auxiliary lane. The lane needs to be associated to the 

corridor, similar to the through lanes. 

Workflow for Individual Lane 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts: 

Prompt User Action 

Locate First 

Superelevation Section 

Select the first section. 

Locate Next 
Superelevation Section or 
Reset to Complete 

Reset to move to the next prompt. 

Type Options include: Primary (calculations based on rules) or Auxiliary 
(based on user- defined). After the selection, the dialog/heads-up 
prompts change to reflect the selection. 

Application Type (Aux. 

lane only) 

How to define cross-slope: 

None - no cross slopes are assigned. 

Constant - Fixed slope of specified value. If lane is transition, use this 
option, and then modify one end in the editor or graphically after 
creation. 
Follow Adjacent - Projects cross slopes from adjacent lane to this lane. 

Select Side of Centerline Right or left 

Inside Edge Offset Enter the offset (in master units) from the baseline reference. If the lane 
edge is the baseline reference, enter 0. 

Width Enter the width of the lane (in master units). If the lane is of varying 
widths, you can use the widest width, or narrower than the width. In 
both cases, the template can control the width by parametric constraints 
or graphical features. 

Start Station Graphically define (based on the dashed line perpendicular to the 
reference element) the beginning of the lane. Station can be keyed in 
and locked. 

End Station Graphically define (based on the dashed line perpendicular to the 
reference element) the end of the lane. Station can be keyed in and 
locked. 

Normal Cross Slope Enter the default cross slope to be used for calculations (in percent 
format). It is not necessary to add the percent sign. 
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 Calculate Superelevation 

The rules-based tool uses a preferences file (SEP) to compute the station and cross slopes of 

transitions. 

Workflow 

1. Select Calculate Superelevation. 

2. Follow the heads-up prompts for SEP file. 

 

Prompt User Action 
Locate First Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, drag your 
cursor diagonally across all desired sections. Your diagonal defines a square 
wherein the entire section must be encompassed in order to be included. 

Locate Next Superelevation 

Section; or Reset to Complete 

Continue selecting sections until all are highlighted, then reset to move to the next 
prompt. 

Standards File Name Select the SEP containing the superelevation standards/parameters. Use 

<ALT> <DOWN> to open the File Manager to select directory/file. Data prompt 
to accept and move to the next prompt. 

Note: The prompts below and their options may vary based on the options within the SEP file. 

e Selection 

L Selection 
The available e and length Selection fields are filled in according to the SEP file.  

Those combo boxes determine which table within the .sep file will be used for 
computation. 

Design Speed Design Speed is to be used either in the tables or equations for e and length 

computations. 

Pivot Method Rotation only 

Transition ID Linear or a variety of parabolic options, based on the settings in the SEPs. If the 
SEP file is set to parabolic, then the following options are supported: 

 
Parabolic reverse curve - This symmetrical option utilizes the parabolic transition 
with no tangent and the length of each parabola is one-half the transition length. 

 

 
 

Parabolic Reverse Nonsymmetrical Curve 1 - Lengths of the two parabolas are 
specified: Sag parabolic Length (L1) =45 and Crest Parabolic Length (L2) = 55. 
The Tangent Length = Transition Length - (L1+L2) as depicted below. 
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Parabolic Reverse Nonsymmetrical Curve 2 - Lengths of the two parabolas are 
specified: Sag parabolic Length (L1) =30 and Crest Parabolic Length (L2) = 40. 
The Tangent Length = Transition Length - (L1+L2) as depicted above. 

 

The values of the parabolic lengths are set by configuration variables by default. 

To change the values, add the configuration variable and the desired values. 

Number of Lanes Used to determine when adjustment factors are applied. 

Facility Divided or undivided: determines which values to use for Distribute Over and % on 

Tangent options. 

Ease Length Not utilized in SEP files. 

Add Constraints Not supported in SEP files. 

Open Editor When calculations are complete and lanes updated, the superelevation editor is 
opened and populated with the new calculated lanes. 
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 Import Superelevation 

In lieu of using rule-based superelevation transitions, the data may be imported from a CSV file, 

where calculations are done outside of the Civil products and just the results are imported. In this 

case, rules do not apply, so no SEP is needed or specified. 

Entire projects can be imported, in which case, only one superelevation section is needed. 

However, you can also import just a turn lane or two, or part of your project. Keep in mind the 

superelevation section and lanes must be created prior to importing, and lane names associated 

with the graphics must match the names in the import file. 

The Windows delimiter value is used, which is generally set to comma; however, if you are 

experiencing difficulties, you may want to verify this on your workstation or laptop. 

If a file is imported twice, duplicate lanes are not created; rather the values of the import file 

overwrite any values (including manual edits) of lanes. 

The file format of the comma separated values file is: 

  

Data Description 

Superelevation Lane Links the data to an existing superelevation lane. 

Station Units should match design file. 

Station equations supported based on the sections reference alignment. 

Cross Slope Formatted as a double value : ±0.0 (i.e. -2% == -0.02) 

Pivot About Enumerated list: {LS,RS} LS = left side 

RS = right side 

 

The following details the optional information:  

Data Description 

Point Type Enumerated list: 
{NC,NCIN,NCOUT,LC,LCIN,LCOUT,RC,RCIN,RCOUT,FS,FSIN,FSOUT,U} 

 
NC = Normal Crown, LC = Level Crown, RC = Reverse Crown, FS = Full Super, U = 
Undefined 

Transition Type Enumerated list : {L,PC,PRC,BRC,CRC,SRC} 

 
L = Linear, PC = Parabolic Curve, PRC = Parabolic Reverse Curve, BRC = Biquadratic 
Reverse Curve, CRC = Cubic Reverse Curve, SRC = Symmetrical Reverse Curve 

Non-Linear 
Curve Length 

Default Value = 0.0 
 

Only pertinent for transition type: parabolic curve or symmetrical reverse curve. 
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Workflow 

1. Create the CSV file, based on file format. 

2. Create superelevation section and lanes, ensuring the lane names match those used in the 

CSV file. 

3. Select the Import Superelevation tool. 

4. Follow the heads-up prompts: 
 

Prompt User Action 
Locate First 
Superelevation Section 

Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines a 
square wherein the entire section must be encompassed in order to be 
included. 

Locate Next 
Superelevation Section or 
Reset to Complete 

Continue selecting sections until all are highlighted, then reset to move to the 

next prompt. 

 

 

 

  
Import File 

Name 

Use <ALT> <DOWN> to open the File Manager to select directory / CSV file. 
 

The results look identical to those of the calculated superelevation lanes. All functionality (i.e., 

editor, graphic manipulation, etc.) supported for calculation lanes is also supported for imported 

lanes, aside from reprocessing. 

 

Editing Lanes 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed into 

the edit field. Slopes can be changed by keying the slope into the edit field. 
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 Assign Superelevation to Corridor 

At any time during the process, the superelevated lanes can be associated with a corridor. If the 

superelevated lanes are in a different file than the corridor, you must be in the corridor file with 

the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 

Workflow 

1. Verify that the template has the Superelevation Flag set for all pavement points used as 

candidate superelevation points. This flag is used for automatically setting the point 

controls.  To discover if the Flag has been applied to the template, Open the Edit 

Template Drop and select the Template Drop handle. Once inside the Editor, double click 

on the EOP point. 

 

2. From within the DGN containing the corridor model, select the Assign Superelevation to 

Corridor tool. 

3. Follow the heads-up prompts. 

Select the first section. In lieu of selecting each section individually, drag your cursor diagonally 

across all desired sections. Your diagonal defines a square wherein the entire section must be 

encompassed in order to be included. 

 

Prompt User Action 
 

Locate First 
Superelevation 
Section 

Select the first section. In lieu of selecting each section individually, drag 

your cursor diagonally across all desired sections. Your diagonal defines 

a square wherein the entire section must be encompassed in order to be 

included. 

 
Locate Next 
Superelevation 
Section or Reset 
to Complete 

Continue selecting sections until all are highlighted, then reset to move to 

the next prompt. 
 

Locate Corridor Select the corridor wherein the superelevation transitions are to be 

applied. 



Chapter 7 – Superelevation    GEOPAK Road 1 
 

 

7-14 Missouri Department of Transportation 4/26/16 

The Associate Superelevation dialog is displayed. 

 

1. If the information is correct, click OK. If not, click Cancel and review the template. 

Superelevation has been incorporated into the corridor model. 

2. Generate a dynamic cross section view to see the superelevation. 

 Insert Superelevation/Cross slope 

There may be times when an additional station and cross slope transition need to be added to an 

existing superelevation lane. Rather than deleting the lane and recreating it, the Insert 

Superelevation Station/Cross-slope tool can be used. 

Workflow 

1. Select Superelevation Station/Cross-slope. 

2. Follow the heads-up prompts. 

Prompt User Action 
Locate Superelevation Select a previously created superelevation lane 

that has superelevation calculations already 

assigned. 
Locate Reference Element Select the Civil horizontal element to be used 

as a basis for superelevation lanes and 

calculations. 
Start Station Graphically define (based on the dashed line 

perpendicular to the reference element) the 

beginning of the section. The station can be 

keyed in and locked. 
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 Superelevation Editor 

The superelevation editor is another way to edit the data, in a tabular format. Any changes made 

in the editor are automatically synced with the graphic lanes and vice versa. Any data in gray 

cannot be edited, due to constraints used during calculations with the SEP method. 

 

The editor is opened by selecting the tool, then selecting the superelevation section(s). The curve 

sets are listed along the left side. Highlighting any curve set populates the table. Colored points 

indicate: 

 Red - fully constrained 

 Yellow - partially constrained 

 Green - not constrained 

Between the diagram and the table are 

numerous short-cut icons to the 

superelevation tools. 

The superelevation diagram at the top is 

display only. Right click on the 

superelevation diagram to display the 

Superelevation Display List dialog. 

The fields in the editor can be customized so unused or unwanted fields can be hidden. This is 

accomplished by right-clicking on any Header in the tabular data area to open the pop-up menu. 
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 Superelevation Report 

Superelevation reports can be generated for a single or multiple sections. Reports are displayed in 

the Civil Report browser. 

Workflow 

1. Select Superelevation Report. 

2. Follow the heads-up prompts. 
 

Prompt User Action 

Name Name each section, suggestions include alignment name which can be appended 
-1, 2, etc. for projects with multiple sections. 

Locate Reference Element Select the Civil horizontal element to be used as a basis for superelevation 
lanes and calculations. 

Start Station Graphically define (based on the dashed line perpendicular to the reference 
element) the beginning of the section. The Station can also be keyed in and 
locked. 

 

 Display Superelevation In Plan 

Use the Display Superelevation in Plan command to automatically generate annotation for 

superelevation station information in plan view. 

The command uses the MicroStation active symbology to display the lines and the text. The user 

sets active text height and width, color, line weight, and line spacing. The line spacing is used to 

offset the text from the top and bottom of the superelevation lines. The justification is hardcoded 

to be center bottom to the right of the alignment and center top to the left for the station values. 

The cross slope value is displayed using left center justification. 

The arrow head uses the active text height to determine its height. 

All text, offsets, and the height of the arrow head are scaled by the MicroStation annotation scale 

factor. 

Workflow 

1. Select Display Superelevation in Plan. 

2. Follow the heads-up prompts. 
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7.9 Group Exercise – Road 1 Superelevation 

1. Within the J2P0200\data_07 folder, open the file: Corridors_J2P0200.dgn 

2. Create a new file named Superelevation_J2P0200.dgn based on the following 2D seed 

file: 

 pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn.   

3. Reference in the following file: 

Civil_Geometry_J2P0200.dgn 

 

Create Superelevation Sections 

4. From the Corridor Modeling task choose Create Superelevation Sections.  

5. When prompted for the Name key in Road1 and data point or tab to accept. 

 

6. When prompted to Locate Reference Element data point on the Road1 horizontal 

geometry. 

 

7. When prompted to enter the Start Station either select the beginning of Road, key in 0 for 

the station or press the Alt key to lock to the beginning station.  Data point to accept. 

 

8. When prompted to enter the End Station either select the end of Road, key in 3510.08 for 

the station or press Alt to lock to the ending station.  Data point to accept. 

 

9. There is only one curve on this section of Road1so there is no tangent length between 

curves.  Therefore enter a Minimum Tangent Length of 0.  Data point to accept. 
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Note:  If the geometry had multiple curves with different design speed then you would 

create multiple Superelevation Sections. 

Create Superelevation Lanes 

10. When prompted Enter Lane Name, key in South (stationing starts at the north end of 

Road1).  Data point to accept. 

11. Verify Type is set to Primary.  Data point to accept. 

 

12. When prompted to Select side of the centerline, select Right from the drop-down menu 

by using the down arrow.  Data point to accept. 

 

13. There is no offset.  So when prompted to Enter the offset value for the inside edge, enter 

0.00.  Data point to accept. 

 

14. In the Enter the Width field, key in the width of the lane.  This value is based on the 

template assigned to the corridor.  Key in 12.00.  Data point to accept. 

 

In the Normal Cross Slope dialog, enter a normal cross slope of -2%.  Data point to 

accept. 

 

15. When prompted to Enter Lane Name, enter North.  Data point to accept. 

16. Set the Type to Primary.  Data point to accept. 

17. Set the Side of Centerline to Left.  Data point to accept. 

18. There is no offset.  Set the Inside Edge Offset to 0.00.  Data point to accept. 

19. Enter a Width of 12. Data point to accept. 

20. Enter a Normal Cross Slope of -2%.  Data point to accept. 

21. Reset to continue. 
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Calculate Superelevation 

22. Open the Calculate Superelevation Tool.    

23. Select <Alt> + Down or use the dialog box to pick the MoDOT_Standard_Plans-

Undivided.sep file delivered in the workspace.  

T:\MoDOT_Workspace\Gpk_Std\Superelevation\ MoDOT_Standard_Plans-Undivided.sep 

Data point to accept. 

24. In the Select e Selection prompt select 8% e max by using the down arrow.  Data point 

to accept. 

 

25. For L Selection select all cases.  Data point to accept. 

 

26. Select a Design Speed of 50.  Data point to accept. 

 

27. For Transition ID select Linear.  Data point to accept. 

 

28. Select 2 for the Number Of Lanes.  Data point to accept. 

 

29. Select Undivided in the Select Facility option.  Data point to accept. 
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30. Select Yes for the Open Editor.  This brings up the Superelevation Editor dialog.  

Facilitating adjustments to stations to full super, slopes etc. 

 

31. Compress the file and Save Settings. 
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Assign Superelevation to Corridor 

Once the superelevation is created based on the alignment it must be tied to the corridor.  

Assigning the superelevation requires the editing of the corridor model therefore the dgn file 

with the corridor model must be open.  Having the superelevation in a separate design file allows 

one user to work on super and another to work on the corridors.  Also the superelevation 

reference can be turned off when viewing is not required. 

32. Select File > Open and select the Corridor_J2P0200.dgn. 

33. Attach the Superelevation_J2P0200.dgn by opening the References dialog box and 

clicking Tools>Attach…, use the attachment method Coincident – World and No 

Nesting. 

34. Close the References dialog box. 

35. Select the Assign Superelevation to Corridor  in the Corridor Modeling task 

group. 

36. When prompted to Locate First Superelevation Section data point on the Road1 super 

section. 

 

37. There is only one section, when prompted, Reset to Complete. 

 

38. When prompted to Locate Corridor, identify one of the corridor grab handles.  These 

extend from the outside edge of the corridor. 
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39. A dialog with a list of the Superelevation objects will display.  Review to verify.  If 

changes to Stations, priorities, or points are required, they can be made here.  If correct 

click OK. 

 

40. Reset when prompted to Locate First Superelevation Section. 

41. Select File > References. 

42. Click on the frame of View 1. 

43. Turn off the display of reference file named: Superelevation_J2P0200.dgn. 

44. Open View 7 which contains the dynamic cross sections and review the superelevated 

sections. 

45. Select File > Update Server Copy 
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7.10 Individual Exercise - Route 63 Superelevation 

1. Within the J2P0200\data_07 folder, open the file: Superelevation_J2P0200.dgn 

 

Create Superelevation Sections 

2. From the Corridor Modeling task group select the Create Superelevation Sections.  

3. When prompted for the name key in Route63.  Data point to accept. 

4. When prompted to Locate Reference Element, select the RTE63 horizontal geometry. 

5. When prompted for the Start Station, press Alt to lock to the beginning station.  Data 

point to accept. 

6. When prompted for the End Station, press Alt to lock to the ending station.  Data point 

to accept. 

7. There is only one curve on this section of RTE63 so there is no tangent length between 

curves.  Therefore enter a Minimum Tangent Length of 0.  Data point to accept. 

 

Create Superelevation Lanes 

8. When prompted to Enter Lane Name, enter NBInside.  Data point to accept. 

9. Set the Type to Primary.  Data point to accept. 

10. Set the Side of Centerline to Left.  Data point to accept. 

11. The offset value for the inside edge is 30’.  Set the Inside Edge Offset to 30.00.  Data 

point to accept. 

12. In the Enter the width dialog, key in 12.000 for the width of the lane.  Data point to 

accept.  This value is based on the template assigned to the corridor. 

13. Enter a Normal Cross Slope of +2%.  Data point to accept. 

14. When prompted to Enter Lane Name, key in NBOutside.  Data point to accept. 

15. Set the Type to Primary.  Data point to accept. 

16. Set the Side of Centerline to Left.  Data point to accept. 

17. Set the Inside Edge Offset to 42.00.  Data point to accept. 

18. In the Enter the Width key in the 12.000 width of the lane.  Data point to accept. 

19. Enter a Normal Cross Slope of -2%.  Data point to accept. 

20. When prompted to Enter Lane Name, key in SBOutside.  Data point to accept. 
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21. Set the Type to Primary.  Data point to accept. 

22. Set the Side of Centerline to Right.  Data point to accept. 

23. Set the Inside Edge Offset to 42.00.  Data point to accept. 

24. In the Enter the Width key in the 12.000 for the width.  Data point to accept. 

25. Enter a Normal Cross Slope of -2%.  Data point to accept. 

26. When prompted to Enter Lane Name, key in SBInside.  Data point to accept. 

27.  Set the Type to Primary.  Data point to accept. 

28. Set the Side of Centerline to Right.  Data point to accept. 

29.  Set the Inside Edge Offset to 30.00.  Data point to accept. 

30. In the Enter the Width, key in the 12.000 for the width.  Data point to accept.  This value 

is based on the template assigned to the corridor. 

31. Enter a Normal Cross Slope of +2%. 

32. Reset to continue. 

Calculate Superelevation 

33. Select <Alt> + Down or use the dialog box to pick the MoDOT_Standard_Plans-

Divided.sep file delivered in the workspace.  

T:\MoDOT_Workspace\Gpk_Std\ MoDOT_Standard_Plans-Divided.sep.   

Data point to accept. 

 

34. In the Select e Selection prompt, select 8% e max.  Data point to accept. 

35. For the L Selection, select all cases.  Data point to accept. 

36. Set a Design Speed of 70.  Data point to accept. 

37. For the Transition ID, select Linear.  Data point to accept. 

38. Select 4 for the Number Of Lanes.  Data point to accept. 

39. Select Divided for the Select Facility option.  Data point to accept. 
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40. Select Yes for the Open Editor option.  Data point to accept.  This brings up the 

Superelevation Editor dialog for facilitating adjustments to stations, slopes etc. 

  

 

 

 

 

 

 

Assign Superelevation to Corridor 



Chapter 7 – Superelevation    GEOPAK Road 1 
 

 

7-26 Missouri Department of Transportation 4/26/16 

Once the superelevation is created based on the alignment it must be tied to the corridor.   

Assigning the superelevation requires the editing of the corridor model therefore the dgn file 

with the corridor model must be open.   Having the superelevation in a separate design file 

allows one user to work on super and another to work on the corridors.  Also the superelevation 

reference can be turned off when viewing is not required. 

41. Open the Corridors_J2P0200.dgn file. 

42. Turn on the display of the Superelevation_J2P0200.dgn file in View 1 in the References 

dialog box. 

43. Select the Assign Superelevation to Corridor  in the Corridor Modeling task 

group. 

44. When prompted to Locate First Superelevation Section, data point on the Route63 

Super Section. 

45. Reset to complete. 

46. When prompted to Locate Corridor, select one of the Corridor grab handles.  These 

extend from the outside edge of the corridor. 

47. A dialog with a list of the Superelevation objects will display.  Review to verify.  If 

changes to Stations, priorities, or points are required they can be made here.  If correct, 

click OK. 

 

48. Reset when prompted to Locate First Superelevation Section. 

49. Open View 8 which contains the dynamic cross sections and review the superelevated 

sections. 

50. Select File > Update Server Copy 

 


